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New Developments in PetWin 5.2 
April 25, 2017 

 

PetWin 5.2 contains many exciting new updates. PetWin 5.2 enables users to capture a plant-wide 
inventory of power demand. For example, PetWin will calculate blower power requirements, taking into 
account factors such as inlet air temperature and relative humidity, pressure losses in the air delivery 
system, etc. Pumping power may also be tracked, accounting for detailed factors such as pipe material 
and diameter for dynamic head losses. Miscellaneous mechanical power for various treatment 
flowsheet elements also may be tracked. To compliment this new functionality, PetWin also includes the 
facility to easily implement up to three different electricity tariff rates over the day, and these patterns 
can be different across two “seasons” (e.g. summer and winter). With the additional ability to explore 
onsite power generation and heat recovery via CHP, tracking of other costs including consumables (e.g. 
methanol and metal salts) and sludge disposal, PetWin 5.2 has expanded capability as a plant 
management tool. 
 

Power Requirements – General Considerations  
 
PetWin now tracks power requirements for a number of categories or sources. For example, Blower 
Power, Mixing Power, Mechanical Power, Pumping Power, Heating Power, Surface aeration Power, Solid 
Liquid Separation/Disinfection Power, and Heating Ventilation and Cooling Power. This categorization 
allows the power requirements to be easily displayed and itemized.  
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Power is tracked for elements via their Power tabs. All elements can track power demand on either a 
unit volume/flow basis, or a direct user-input kW (or hp) basis. Each of these options can be constant, or 
vary with time as shown below: 
 

 
 
 

Power Requirements – Aeration  
 
Aeration is often the single biggest consumer of power in a wastewater treatment plant. PetWin allows 
you to specify whether an aerated element is part of a group of bioreactors / aerated zones that is 
supplied by a common blower, by defining as many Air supply groups as you like, as shown below: 
 

 



 3 

The total air delivered by a blower to a group of reactors is automatically totalized and used to calculate 
the blower power requirements. You can choose between three methods for calculating blower power 
requirements: 

1. Adiabatic / polytropic power equation (default method); 
2. Linear power equation (power is linearly related to air flow and pressure change); 
3. User defined equation (users can implement complex equations to account for situations such 

as “main” and “standby” blowers). 
 
The power calculations account for a number of important aeration system parameters, including: 

• Blower inlet air conditions (temperature and relative humidity) 
 

 
 

• Blower efficiency (which can be set up to vary with air flow) 

• Total pressure loss through the air delivery system (e.g. piping and valves) 

• Pressure loss across the diffusers (which can be set up to vary with air flow) 
 
The PetWin 5.2 manual contains more detail and examples on the topic of aeration power 
requirements. 
 

Power Requirements – Pumping  
 
Power requirements to pump various flows for a process flowsheet are tracked via the new pump 
element in PetWin. Pumping power can either be calculated or specified as a constant or scheduled 
demand for Pump elements.  
 
 
 
 
 
 
 
 
 
 



 4 

If you choose to have PetWin calculate the power, PetWin will sum all flows entering the pump element 
for use in its power calculation. Furthermore, you can enter the static head, pipe length and pipe inside 
diameter: 
 

 
 
You can also provide information on the pump efficiency (i.e. whether it is constant or varies with flow) 
and the pipe characteristics used for calculation of total dynamic head (e.g. pipe roughness and minor 
loss coefficients), as shown below (PetWin also can account for the impact of high solids concentrations 
on a pumped stream’s viscosity if desired): 
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Heating Requirements – Anaerobic Digester & Thermal Hydrolysis Unit 
 
The heating power requirement is determined for Anaerobic Digester and Thermal Hydrolysis flowsheet 
elements. Typically, the main component of the heating power is the amount of energy required to heat 
an influent stream to the desired operating temperature specified in the Anaerobic Digester and/or 
Thermal Hydrolysis unit elements. Additional heating power may be required in an Anaerobic Digester 
element to overcome a specified digester heat loss, which can vary with time as shown below: 
 

 
 
The heating power requirement is provided from a fuel or electrical source [see later], but there are also 
options in PetWin for heating power recovery within the Anaerobic Digester and Thermal Hydrolysis 
Unit elements: 
 

 
 
When the option to include a heat exchanger is specified, PetWin assumes that the hot digester (or 
THU) output stream is used to heat the cool incoming stream in a counter-current heat exchanger. Users 
can enter the efficiency of the exchanger as well as the temperature difference between the heat 
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exchanger’s hot exit stream and cold entry stream. A schematic representing the difference in 
temperature between the hot exit and cold entry streams for the heat exchanger is shown below: 
 

 
 
It is possible to choose between two heating methods for anaerobic digesters and thermal hydrolysis 
units: 
 

1. Electrical heating which will incur an electricity cost, or  
2. Heating via an external fuel source used in a boiler (i.e. natural gas, heating oil, diesel, or a 

custom fuel) which will incur a cost for fuel. 
 
PetWin 5.2 also allows you to choose how biogas generated in an anaerobic digester is used. The overall 
multiple options for biogas use are shown in the following diagram (and options for additional heating 
needs are identified): 
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Potential Uses for Digester-Generated Biogas in PetWin 5.2 
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Digester biogas may be used in three main ways: 
 

1. Using the biogas in a Combined Heat & Power (CHP) engine. This pathway includes options for 
selling all or left-over generated power; using or selling non-waste heat, and the method used 
for additional digester heating if required (i.e. electrical or use of external fuel). 
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2. Burning the biogas in a boiler for heating and supplementing via electrical or external fuel 
sources if insufficient gas is available. If there is any excess biogas after satisfying heating 
demands, there is an option to sell it. 
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3. Either flaring off or selling all of the gas. For either option, the method used for digester heating 
(i.e. electrical or use of external fuel) must be specified. 
 

 
 

 
The above pathways are selected using the new Anaerobic digester Gas use tab: 
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Power Requirements – New Output Functionality 
 
Power/Energy use plots can be generated semi-automatically in PetWin. These include: 
 

• Power Demand Distribution plots  
o Pie plot of instantaneous power demand 
o Bar plot of instantaneous power demand 

 

• Time Series plots 
o Instantaneous power by category 
o Total and net instantaneous power 
o Energy consumption (Daily) 
o Energy consumption (Monthly) 
o Energy consumption (Yearly) 
o Energy consumption  

 
For power demand distribution and time series plots, you are only required to select the elements that 
you want included in the plots.  PetWin then performs the necessary calculations (such as plotting daily, 
monthly, yearly, and total overall cumulative energy consumption) and generates the plot. You then 
may customize the appearance of the chart using PetWin's powerful chart and series formatting tools. 
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In addition to these plots, you can also add pre-defined power tables to the album: 
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You can add pre-defined air supply group (i.e. blower) tables to the album. These tables show the 
breakdown of power requirements for different air supply groups that have been defined, along with 
various calculated values used in the blower power calculations (e.g. intake pressure, discharge 
pressure, intake airflow): 
 

 
 
Finally, you can add a chart that shows the peak 15-minute power demand for each month over the 
most recent 12 months of simulation; this facilitates calculating and checking demand charges for the 
subsequent month: 
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Variable Alpha & Beta 
 
PetWin has the ability to vary the alpha and beta parameters used in its aeration calculations with time. 
Emerging research and measurement experience has indicated that alpha follows influent loading 
patterns to some degree. You can use this option to fine-tune calibration of PetWin’s aeration model. 
The small chart buttons can be used to rapidly plot a time series of alpha and/or beta. 
 

 
 
Alpha and beta can also be plotted from the general time and current value series dialogue boxes. 
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Costing Calculations 
 
PetWin 5.2 has the facility to track and totalize operating costs using localized currency units in four 
separate categories: 
 

1. Costs associated with energy consumption. 
2. Costs associated with consumption of chemicals / consumables. 
3. Costs associated with sludge disposal. 
4. Costs associated with fuel consumption. 

 

 
 
Electricity costs are an important consideration in any operating cost analysis, and PetWin makes it easy 
to input and account for complex factors such as varying daily rate structures for different seasons and 
peak demand charges. For example, suppose you want to implement an electricity rate structure such as 
the one shown below (HydroOne, 2015): 
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Doing this is simple in PetWin – selecting the seasonal rates option offers a convenient interface for 
setting up different daily electricity rate structures for different seasons.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Chemical costs are tracked in PetWin on a global basis for consumables such as methanol or metal salts 
on a cost per unit volume basis, as shown below. Also, you have the option to include individual 
elements from your flowsheet in the overall project cost tracking by checking or un-checking the option 
to include that element on its Costs tab. 
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Sludge disposal costs can be calculated on a unit volume and/or unit mass basis: 
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Cost, energy content, and liquid density for a variety of heating fuels may be specified via the Project > 
Costs/Energy > Fuel/Chemical menu: 
 

 
 

 

 

 

 

 

 

 

 

 

 
There are three potential “cost credit” or “revenue streams” in PetWin 5.2: 
 

1. Sale of CHP power back to the electricity grid. 
2. Sale of CHP-generated heat. 
3. Anaerobic digester biogas. 
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Costing Output 
 
PetWin enables you to look at a detailed dynamic breakdown of “instantaneous” cost for power and 
energy, taking into account the complexity of varying daily energy costs. Furthermore, PetWin will 
automatically keep a running tally of the total energy costs to date: 
 

 
 
Similarly, PetWin will track both the “instantaneous” and running total costs for the entire facility, 
including energy, sludge handling, and chemicals: 
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Speed Improvements 
 
PetWin 5.2 contains significant improvements in both steady state and dynamic simulation speed, 

particularly for (a) large flowsheets incorporating many elements; and (b) systems incorporating biofilm 

elements (e.g. media bioreactors in MBBR and IFAS configurations, submerged aerated filters, trickling 

filters, etc.). 

Speed Improvements - Steady State Simulation 
 
The basic methodology for steady state simulations remains unchanged. That is, PetWin uses a “hybrid” 

solver that combines a Decoupled Linear Search (DLS) method and a Modified Newton-Raphson (MNR) 

method. The solver typically starts with a few iterations of DLS, and then switches to MNR to finish. The 

MNR is much more efficient at obtaining solutions, but it is computationally intensive. For example, in 

previous versions of PetWin, the MNR could take up to several minutes per iteration for systems with 

large, complex flowsheets. Given that several iterations often are required, this translated into steady 

state solution times of 20-30 minutes for very large systems. 

In PetWin 5.2, the numerical engine underlying the MNR method has been replaced, resulting in huge 

gains for large flowsheets. For example, in our internal testing we have systems that were taking ~200 

seconds per iteration reduce to ~4 seconds per iteration, i.e. 50 times faster! 
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Speed Improvements - Dynamic Simulation 
 
PetWin 5.2 uses a new dynamic integration method known as BDF (Backwards Differentiation Formula). 

The BDF method is faster than the previous method for large, complex flowsheets and flowsheets 

incorporating biofilm-based elements. Our PetWin 5.2 testing has indicated: 

• Large systems not incorporating biofilm reactors run 3 – 6 times faster 

• Systems incorporating biofilm reactors run 10 – 50+ times faster 
 

If you open the Project > Current Project Options > Numerical parameters tab shown below, the BDF 

method should be selected as the default method – even for a file you created in a previous version of 

PetWin. The “old” PetWin method (BWHeun) is also still available because the new BDF method is not 

yet available for simulation of SBR systems. 
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Model Change – Diffusion of Colloidal Material in Biofilms 
 
PetWin’s biofilm model has always incorporated a diffusion rate for colloidal material into the biofilm 

layers. This parameter can be found on the Project > Parameters > Biofilm > Effective diffusivities tab 

shown below: 

 

 
In previous versions of PetWin, the default value assigned for the effective diffusivity of colloidal 

material was 5.0 x 10-12. This value is greater than the one assigned to particulate material (e.g. 

particulate degradable COD has a value of 5.0 x 10-14), but lower than soluble material (e.g. soluble 

readily biodegradable COD has a value of 6.9 x 10-10). The fate of colloidal material in biofilm systems is 

directly impacted by this parameter value. For example, consider the system below consisting of four 

moving bed bioreactor (MBBR) units in series: 
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Using the default diffusivity parameters, the soluble COD and BOD profiles are as follows: 
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Note that soluble BOD is not significantly reduced until the end of the third MBBR unit (bottom chart). 

This can be explained by looking at the top chart. Although the uptake of soluble readily biodegradable 

material is nearly complete by the end of the second unit, the uptake of colloidal material is not as rapid 

and much of the soluble BOD leaving the second and third MBBR units is due to colloidal material. 

 
Our investigations into performance of systems like the one pictured above suggests that the soluble 

BOD is removed to a greater extent by the end of the second stage. As a result, in PetWin 5.2 the default 

value assigned for the effective diffusivity of colloidal COD material has been increased to 5.0 x 10-10. 

This value is closer to, but slightly less than, the value assigned to soluble material (recall that soluble 

readily biodegradable COD has a value of 6.9 x 10-10). This results in more complete removal of colloidal 

material by the end of the second stage, and gives the soluble BOD profile shown below: 

 

 

 

Model Change – Dissolved Oxygen Half-Saturation Constant for Phosphorus 

Accumulating Organisms 
 
In previous versions of PetWin, the phosphorus accumulating organisms (PAO) used the same dissolved 

oxygen (DO) half-saturation model parameter as the ordinary heterotrophic organisms (OHO). This 

reflected conventional wisdom which suggested that PAOs did not take up phosphorus effectively at low 

DO concentrations. However, current research (Jimenez et al., 2014) suggests that PAOs are in fact able 

to take up phosphorus effectively at very low DO concentrations. To reflect these findings, PetWin now 

incorporates a separate dissolved oxygen (DO) half-saturation model parameter for PAOs. This improves 

the model’s ability to track biological phosphorus removal behavior in systems operating under low DO / 
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simultaneous nitrification-denitrification conditions. This parameter is found via the Project > 

Parameters > Kinetic > Switches tab shown below: 

 

 

 

Model Change – Compression Settling of Solids 
 
In PetWin users can define a solids concentration that represents the maximum compactability of solids 

in a model settling tank unit (i.e. a limit on underflow TSS concentration). In earlier versions, as the 

solids concentration in a layer of a model settling tank approached the maximum compactability value, 

that layer would “re-suspend” solids into the layer above; in this way the constraint on maximum 

compactability was maintained. This approach was not always satisfactory because (a) under certain 

conditions it resulted in unstable behavior, and (b) it did not properly reflect what physically occurs as 

solids transition from the hindered settling regime to compression settling. 

In PetWin 5.2, the approach for modelling settling behavior at high solids concentrations and imposing a 

maximum compactability has changed. The following section discusses the new approach used at high 

solids concentrations, as well as the approach that has always been used to model settling at low 

concentrations. 

Sludge settling velocity is modeled according to the Vesilind equation for hindered settling.  The settling 

velocity in a given layer is given by: 

𝑉𝑆,𝑖 = 𝑉0 𝑒−𝐾𝑋𝑖  (1) 

 
where 𝑉0 = maximum settling velocity (m/d), 𝐾 = hindered settling parameter (m3/kg TSS), and 𝑋𝑖  = 

total suspended solids (TSS) concentration (kgTSS/m3) in layer i. 



 26 

A criticism of Eq. 1 is that it over-predicts settling velocities at low concentrations.  Furthermore, the 

standard Vesilind equation does not account for compression settling. PetWin employs switching 

functions to switch off the sludge settling velocity expression at very low solids concentrations, and also 

as the solids concentration approaches the maximum solids compactability in the lower layers of the 

settling tank.  This provides a simplified method of modeling the poorly flocculating solids in the upper 

layers of the settling tank, and compression setting in the lower layers.  As the solids concentration in 

the upper layers approaches a user-definable concentration (the upper layer settling velocity switch), 

the settling velocity approaches zero, and solids are carried upwards by the overflow stream (resulting 

in solids in the settling tank effluent). As the solids concentration in the lower layers approaches the 

user-definable maximum compactability, the settling velocity is quickly and smoothly reduced to zero. 

The complete settling velocity equation used by PetWin is: 

𝑉𝑆,𝑖 = 𝑉0 𝑒−𝐾𝑋𝑖 ⋅ (
𝑋𝑖

𝐾𝑆 + 𝑋𝑖
) ⋅ (

1

1 + 𝑒−𝐶𝑜𝑚𝑝𝑟𝑒𝑠𝑠𝑖𝑜𝑛 𝑆𝑒𝑡𝑡𝑙𝑖𝑛𝑔 𝑇𝑟𝑎𝑛𝑠𝑖𝑡𝑖𝑜𝑛 𝐹𝑎𝑐𝑡𝑜𝑟⋅(𝑋𝑀𝐴𝑋−𝑋𝑖)
) (2) 

 
Where KS is the upper layer settling velocity switch, XMAX is the maximum compactability, and other 

variables are the same as in Eq. 1. 

The switching function effect at low concentrations for a given combination of settling velocity 

parameters is shown in the figure below: 

 

 

You can increase the suspended solids concentration at which settling velocity is decreased by 

increasing the KS parameter. Varying the KS parameter is a possible way to vary the predicted effluent 

suspended solids. 
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The switching function effect at high concentrations in the lower layers of the settling tank for a given 

combination of settling velocity parameters is shown in the figure below. Lowering the XMAX parameter is 

a way to simulate poorly compressible bulking sludge. 

 

 

 

Usability Improvements 
 

In addition to the new features above, a number of usability improvements have been made, 
including: 
 

• Input diffuser coverage as diffuser density, ATAD, or diffuser count. PetWin 

automatically converts from one basis to another. 
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• You can choose whether or not the Notes window is displayed when you open a PetWin 
file, by checking or unchecking the Automatically show notes after loading file box 
under Tools > Customize > General 

 
• Users of previous versions of PetWin reported a “sluggish” behavior in PetWin files that 

incorporated very large tables in the PetWin Album. This is no longer the case, so long 
as the user does not set PetWin to update tables continually during simulations. The 
Steady state simulation table updates and Dynamic simulation table updates 
checkboxes should remain at the default unchecked state. 

 
• Diffuser parameters are now globally applied to all bioreactors by default (although they 

can still be localized if desired). There is now a Diffuser tab under Project > Parameters 

> Aeration/Mass transfer… that can be used to easily set up the same diffuser 

characteristics across all bioreactors from one interface. 
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• The diffuser parameters can now be quickly toggled between values representative of 

fine or coarse bubble diffusers, using the “Set example fine bubble diffusers” or “Set 

example coarse bubble diffusers” buttons. 

 

• PetWin has new default fine bubble diffuser parameters that are more representative of 

current diffuser materials and performance. 
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• Right-clicking on any pattern input to PetWin (e.g. flow, RAS) now offers two options: 

Copy (which copies the pattern without headings and can be used to copy a pattern 

from one place to another within PetWin), and Copy all (which copies the pattern with 

headings and can be used to copy a pattern from PetWin into a Word, PowerPoint, or 

Excel table). 

 

• A progress bar now shows at the bottom of the simulation control box while PetWin 

places numerical seed values in all flowsheet elements. This will only be readily evident 

on large flowsheets with many elements. 

 

• Alarms will be generated for anion/cation limitation conditions. 

 

• Right-click menu for adding a chart contains short-cuts for adding time series and 

current value series. 

 

• The gas phase is now shown for MBR mass balance windows. 

 

• Parameter temperature correction factors are now highlighted in red if they have been 

changed from default values. 

• Improved plotting series naming for multi-layer elements (e.g. SAF). 
 

• It is now possible to display a Rates window for a SAF element. 
 

• Tighter numerical adherence to splitters with “zero” fractions and rates specified for a 
stream. 

 

• Anaerobic digesters and variable volume bioreactors may now be set to “constant” 
volume. 

 

• Biofilm details tables in the Album may now be copied to the clipboard for exporting to 
Excel. 

 

• Pop-up hints have been added to clarify pipe minor loss calculations in pump flowsheet 

elements. 
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• If a CHP engine is associated with an anaerobic digester element, red text is shown in 

the fly-by pane as a visual indicator. 

 

 
 

• Improved handling of how PetWin Album tables and charts are added to the PetWin 

Notes editor via the right-click “Add to notes” command. For example, tables are 

automatically formatted before being pasted to the Notes editor and tables with many 

columns are automatically divided into smaller tables that will fit the Notes editor: 
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• The software package that PetWin uses for its charting engine (TeeChart) has updated 
to a new version. The functionality is similar to what it was in previous PetWin versions, 
but the interface has changed somewhat. 

 

Further details on all new features in PetWin 5.2 can be found in the Help manual.  

 

 


